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Important notice

1 Important notice

NXP provides the enclosed product(s) under the following conditions:

This evaluation kit is intended for use of ENGINEERING DEVELOPMENT OR EVALUATION PURPOSES ONLY.
It is provided as a sample IC pre-soldered to a printed circuit board to make it easier to access inputs, outputs, and
supply terminals. This evaluation board may be used with any development system or other source of I/0O signals
by simply connecting it to the host MCU or computer board via off-the-shelf cables. This evaluation board is not a
Reference Design and is not intended to represent a final design recommendation for any particular application.
Final device in an application will be heavily dependent on proper printed circuit board layout and heat sinking
design as well as attention to supply filtering, transient suppression, and 1/O signal quality.

The goods provided may not be complete in terms of required design, marketing, and or manufacturing related
protective considerations, including product safety measures typically found in the end product incorporating the
goods. Due to the open construction of the product, it is the user's responsibility to take any and all appropriate
precautions with regard to electrostatic discharge. In order to minimize risks associated with the customers
applications, adequate design and operating safeguards must be provided by the customer to minimize inherent or
procedural hazards. For any safety concerns, contact NXP sales and technical support services.

Should this evaluation kit not meet the specifications indicated in the kit, it may be returned within 30 days from the
date of delivery and will be replaced by a new kit.

NXP reserves the right to make changes without further notice to any products herein. NXP makes no warranty,
representation or guarantee regarding the suitability of its products for any particular purpose, nor does NXP
assume any liability arising out of the application or use of any product or circuit, and specifically disclaims any and
all liability, including without limitation consequential or incidental damages. “Typical” parameters can and do vary
in different applications and actual performance may vary over time. All operating parameters, including “Typical”,
must be validated for each customer application by customer’s technical experts.

NXP does not convey any license under its patent rights nor the rights of others. NXP products are not designed,
intended, or authorized for use as components in systems intended for surgical implant into the body, or other
applications intended to support or sustain life, or for any other application in which the failure of the NXP product
could create a situation where personal injury or death may occur.

Should the Buyer purchase or use NXP products for any such unintended or unauthorized application, the Buyer
shall indemnify and hold NXP and its officers, employees, subsidiaries, affiliates, and distributors harmless against
all claims, costs, damages, and expenses, and reasonable attorney fees arising out of, directly or indirectly, any
claim of personal injury or death associated with such unintended or unauthorized use, even if such claim alleges
NXP was negligent regarding the design or manufacture of the part. NXP™ and the NXP logo are trademarks of
NXP Semiconductors. All other product or service names are the property of their respective owners.

© 2016 NXP B.V.
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Getting started

2 Getting started

21 Kit contents/packing list
21.1 FRDM-BC3770-EVM

If you ordered the FRDM-BC3770-EVM, your kit contents include:
» Assembled and tested evaluation board/module in anti-static bag.
* FRDM-KL25Z Freedom board with programming loaded
» Two USB Mini-B to Standard-A cables
* Quick Start Guide, Analog Tools
» Warranty card

2.1.2 FRDM-BC3770-EVB

If you ordered the FRDM-BC3770-EVB, your kit contents include:
» Assembled and tested evaluation board/module in anti-static bag.
* Quick Start Guide, Analog Tools
» Warranty card

2.2 Jump start

NXP’s analog product development boards help to easily evaluate NXP products. These tools support analog mixed signal and power
solutions including monolithic ICs using proven high-volume SMARTMOS mixed signal technology, and system-in-package devices
utilizing power, SMARTMOS and MCU dies. NXP products enable longer battery life, smaller form factor, component count reduction,
ease of design, lower system cost, and improved performance in powering state of the art systems.

* Go to www.nxp.com/FRDM-BC3770-EVB

» Review your Tool Summary Page

» Look for

Jump Start Your Design

* Download documents, software, and other information
Once the files are downloaded, review the user guide in the bundle. The user guide includes setup instructions, BOM, and schematics.
Jump start bundles are available on each tool summary page with the most relevant and current information. The information includes
everything needed for design.

2.3 Required equipment and software

To use this kit, you need:

* A Win 32 or higher PC

A Lithion lon (or Lithium Polymer) battery 3.7 V — 4.2 V, Max Charge Current 2.0 A

» Two USB Mini-B (Male) to Standard-A (Male) cables (included in FRDM-BC3770-EVM kit)
* A FRDM-KL25Z board with programming loaded (included in FRDM-BC3770-EVM kit)

24 System requirements

The kit requires the following to function properly with the software:
« Windows® XP, Windows 7, or Vista in 32- and 64-bit versions, Windows 8

Freedom expansion boards FRDM-BC3770-EVB and FRDM-BC3770-EVM, Rev. 2.0
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Understanding the Freedom platform

3 Understanding the Freedom platform

The NXP Freedom development platform is a small, low-power, cost-effective evaluation and development system for quick application

prototyping and demonstration of Kinetis MCU families. The assembled platform incudes the FRDM-BC3770-EVB expansion board
mounted to the KL25Z board.

FRDM-BC3770-EVB

FRDM-KL25Z

Figure 2. Freedom development platform

3.1 FRDM-BC3770-EVB

The Freedom expansion board FRDM-BC3770-EVB is a fully programmable switching charger with dual-path output for single-cell Li-lon
and Li-Polymer battery. This dual-path output allows mobile applications with fully discharged battery or dead battery to boot up the
system. The high-efficiency and switch-mode operations of the BC3770 reduce heat dissipation and allow a higher current capability for
a given package size. In addition, the FRDM-BC3770-EVB features a single 20 V maximum input and charges the battery with a current
of up to 2.0 A. The charging parameters and operating modes are fully programmable over an I2C Interface operating up to 400 kHz.
Features
+ The FRDM-BC3770-EVB is a highly integrated synchronous switch-mode charger, featuring integrated OVP and Power
FET.
» The charger and boost regulator circuits switch at 1.5 MHz to minimize the size of external passive components
« The BC3770 is able to operate as a boost regulator for USB-OTG function via either I2C command or an external pin from
the host/processor

« The BC3770 is available in a 25-bump, 2.27 mm x 2.17 mm, WLCSP package

Freedom expansion boards FRDM-BC3770-EVB and FRDM-BC3770-EVM, Rev. 2.0
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Understanding the Freedom platform

3.2 FRDM-KL25Z

The FRDM-KL25Z is an ultra-low-cost development platform for Kinetis L Series KL1x (KL14/15) and KL2x (KL24/25) MCUs built on the
ARM® Cortex™-MO0+ processor. Features include easy access to MCU 1/O, battery-ready, low-power operation, a standard-based form
factor with expansion board options, and a built-in debug interface for flash programming and run-control. The FRDM-KL25Z is supported
by a range of NXP and third-party development software.

The user can use mbed.org at no charge, with full access to the online SDK, tools, reusable code (no downloads, installations or licenses),
and an active community of developers.

3.2.1 Features

* MKL25Z128VLK4 MCU - 48 MHz, 128 KB flash, 16 KB SRAM, USB OTG (FS), 80LQFP

» Capacitive touch “slider,” MMA8451Q accelerometer, tri-color LED

» Easy access to MCU I/O

» Sophisticated OpenSDA debug interface

» Mass storage device flash programming interface (default) - no tool installation required to evaluate demo apps

» P&E Multilink interface provides run-control debugging and compatibility with IDE tools

» Open-source data logging application provides an example for customer, partner and enthusiast development on the

OpenSDA circuit

* mbed™ enabled
To view an online video providing an introduction to using the FRDM-KL25Z, go to the following URL:
http://www.NXP.com/webapp/video_vault/'videoSummary.sp?code=FRDMKL25ZINTRO_VID

3.3 Block diagram

The high level system block diagram here outlines the way the NXP standard products are used to implement an example airbag ECU.
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Figure 3. BC3770 simplified block diagram
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4 Getting to know the hardware

The Freedom platform consists of the FRDM-BC3770-EVB board mounted to a FRDM-KL25Z board.

41 FRDM-BC3770-EVB board overview

The FRDM-BC3770-EVB expansion Board (EVB) is an easy-to-use circuit board allowing the user to exercise all the functions of the

MC32BC3770CS fully programmable switching charger. A PC communicates to the EVB through the FRDM-KL25Z's USB communication
port.

411 FRDM-BC3770-EVB board description

The FRDM-BC3770-EVB board consists of the MC32BC3770CS chip and its associated circuitry.

MC32BC3770CS
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Figure 4. FRDM-BC3770-EVB (top view)
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Getting to know the hardware
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Figure 5. FRDM-BC3770-EVB (bottom view)

Table 1. Board description

Name Description
MC32BC3770CS A fully programmable switching charger with dual-path output for single-cell Li-lon and Li-Polymer battery
Current Sense Amplifiers Three integrated current sense amplifiers (CSAs) permit the real-time measurement of current and voltage on

the VBUS input supply, the VSYS output supply and the battery (VBAT)

A programmable electronic load (ELOAD), 0 A to 1.0 A, in 50 mA steps. It is used to demonstrate system per-
formance with an active load applied to either the VSY supply, or the battery VBAT. When attached to the bat-
tery, the ELOAD can be used to discharge the battery in a controlled manner

Power Supply
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Getting to know the hardware

41.2 LED display

The following LEDs are provided as visual indicators on the FRDM-BC3770-EVB evaluation board:
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Figure 6. LED locations on the FRDM-BC3770-EVB evaluation board

Table 2. LEDs

Schematic label Name Description

This indicates the target has been selected/deselected
through the GUI. It turns on when the target is selected and
LED1 LED Green turns off when the target is deselected. (Note: Exiting the
GUI while the target is still selected results in the LED
remaining on.)

This indicates the presence of charge current. It turns on

LED2 LED Red when a charge current of 10 mA or greater occurs.
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Getting to know the hardware

4.1.3 Connectors

Input/output connectors function as follows:
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Figure 7. Connector locations on the FRDM-BC3770-EVB evaluation board

Table 3. Connectors

Schematic label Name Description
J1 CON_2X8 2 x 8 Female Arduino connector. Supports addition of shield boards.
J2 CON_2X10 2 x 10 Female Arduino connector. Supports addition of shield boards.
J3 USB MINI-B USB Mini port supplies power to the Freedom platform
Three-position detachable terminal block. The bottom terminal connects to positive
J6 TB_3x1 battery pole and the middle terminal connects to negative battery pole. The top termi-
nal is used for battery detection.
8 B 2x1 Two-position detachable terminal block. Supports eternal temperature measurement
— (NTC). Note: currently not supported in software.
J9 CON_2X8 2 x 8 Female Arduino connector. Supports addition of shield boards.
J10 CON_2X6 2 x 6 Female Arduino connector. Supports addition of shield boards.
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4.1.4 Test point definitions

Figure 8 and Table 4 define the evaluation board test points and their locations.
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The following test-point jumpers provide access to signals on the MC32BC3770CS IC:

Table 4. Test points
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Getting to know the hardware
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Figure 8. Test point locations on the FRDM-BC3770-EVB evaluation board

Schematic label Description
BOOT Bootstrap Capacitor Voltage
ELOAD_DAC Voltage DAC Output
LDAC DAC Address Latch
LX Buck Supply Switching Node
NCHGEN Charger Enable (Active Low)
NINT Interrupt Out (Active Low)
NSHDN Charger Shutdown (Active Low)
NTC_TEMP NTC Thermistor Voltage
PMID BC3770 VBUS Bypass Output
RDY/BSY DAC Ready/Busy Output
SCL1 I2C Clock Signal to the BC3770

Freedom expansion boards FRDM-BC3770-EVB and FRDM-BC3770-EVM, Rev. 2.0
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Getting to know the hardware

Table 4. Test points (continued)

Schematic label

Description

SCL2 I2C Clock Signal to other devices

SDA1 I2C Data Signal to/from BC3770

SDA2 I2C Data Signal to/from other devices

VBAT Battery Positive Terminal
VBAT_ALERT VBAT CSA Interrupt

VBUS USB/Charge Source Input
VBUS_ALERT VBUS CSA Interrupt

VL BC3770 Internal Regulator Output (Do not Load)

VSYS System Supply Output
VSYS_ALERT VSYS CSA Interrupt

PGND1 Analog Power Ground

PGND2 Analog Power Ground

PGND3 Analog Power Ground

Freedom expansion boards FRDM-BC3770-EVB and FRDM-BC3770-EVM, Rev. 2.0
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Getting to know the hardware

4.1.5 Jumper definitions

The following table defines the evaluation board jumper positions and explains their functions.
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Figure 9. Jumper locations on the FRDM-BC3770-EVB evaluation board

Table 5. Jumpers

Jumper Name Description (Pdl:fsa:;tz) Pins 2-3
J4 VBUS Input Power Source For Charger Shorted -
J5 VDDIO Power Source for Digital Interface Shorted -
J7 CHGOUT Charger Output to Battery Shorted -
J11 VSYS Power Output to System Load Shorted -
J12 NOBAT Shorted -
J20 LD | Connects ELOAD to VBAT or VSYS VBAT VsYs
J21 VDAC VDAC Output to drive ELOAD Shorted -

Freedom expansion boards FRDM-BC3770-EVB and FRDM-BC3770-EVM, Rev. 2.0
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Getting to know the hardware

4.2 Accessory interface board

The FRDM-BC3770-EVB kit is typically used with the FRDM-25KLZ shown in Figure 10. The FRDM-KL25Z is an ultra-low-cost
development platform for Kinetis L Series KL1x (KL14/15) and KL2x (KL24/25) MCUs built on ARM® Cortex™-MO0+ processor. Its features
include easy access to MCU I/O, battery-ready, low-power operation, a standard-based form factor with expansion board options, and a
built-in debug interface for flash programming and run-control. The FRDM-KL25Z is supported by a range of NXP and third-party
development software.
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Figure 10. FRDM-KL25Z Freedom development platform

For more information on the FRDM-KL25Z board, go to the NXP product summary page at:
http://www.NXP.com/webapp/sps/site/prod_summary.jsp?code=FRDM-KL25Z

Freedom expansion boards FRDM-BC3770-EVB and FRDM-BC3770-EVM, Rev. 2.0
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5.1 Video tutorials

Installing the software and setting up the hardware

Installing the software and setting up the hardware

A series of video tutorials provide in depth information on the operations described in this section. To access these tutorials, go to the
following url:http://www.nxp.com/webapp/sps/site/prod_summary.jsp?code=FRDM-BC3770-EVB. In the “Jump Start Your Design” block,

click on the “How To Videos” link.

Click
Here

Jump Start Your Design

Get Started with the FRDM-BC3770-EVB Evaluation Kit

Everything you need to get started with the FRDM-BC3770-EVB ...

How to Videos

BC3770 battery charger graphical user interface (GUI) ...

The following tutorials apply to this section

Table 6. Video tutorials

Title

Description

01A - BC3770 GUI Install Video

Describes how to download and install the GUI on a PC

01B - BC3770 Battery Connections Video

Describes the Freedom platform links to a Lithium lon battery, the PC, and a power supply

01C - BC3770 GUI Launch Video

Describes how to launch the GUI and verify the connections

02 - BC3770 GUI Main Log Video

Describes the GUI Startup screen and the use of the Main Log

03 - BC3770 GUI I2C Communication Video

Describes how to control 12C Communications through the GUI

04 - BC3770 GUI Control Registers Video

Describes the GUI Control Register functions (System, VBUS, Charger, and Interrupt register parameters)

05 - BC3770 GUI Script Editor Video

Describes GUI scripting capability

06 - BC3770 GUI Charge Plots Video

Describes the GUI Charge Plot function

07 - BC3770 GUI Discharge Plots Video

Describes the GUI Discharge Plot function

08A - BC3770 GUI Load Sharing Video

Describes the load sharing support via the GUI

08B - BC3770 GUI Battery Supplement Video

Describes battery supplement support via the GUI

08C - BC3770 GUI OTG Boost video

Describes OTG Boost support via the GUI

5.2

Installing the MC32BC3770 graphical user interface on the computer

The latest version of the MC32BC3770 GUI is designed to run on any Windows 8, Windows 7, Vista, or XP-based operating system.

To install the software:

* Go to www.nxp.com/analogtools and select the kit.

+ Click on the link to open the corresponding Tool Summary Page.

» Look for “Jump Start Your Design”.

» Download the MC32BC3770_GUI(x.x.x.x) file to a directory on the computer.

* Open the MC32BC3770_GUI_(x.x.x.x).zip file and extract the compressed files. (The software creates a subdirectory
containing the extracted files.)

» Open the subdirectory containing the extracted files and run the setup.exe file. The Installation Wizard guides the user
through the rest of the process.

» When the installation completes, the MC32BC3770 Charger Panel GUI automatically opens on the computer. In addition,
a BC3770_GUI icon appears on the desktop.

For an in-depth tutorial on installing the MC32BC3770 GUI, see the video “01A - BC3770 GUI Install Video” in the FRDM-BC3770-EVB

Product Summary page.

5.3

To launch the MC32BC3770 GUI:

Starting the MC32BC3770 GUI

Freedom expansion boards FRDM-BC3770-EVB and FRDM-BC3770-EVM, Rev. 2.0
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Installing the software and setting up the hardware

» From your desktop, click on the BC3770_GUI icon. The Graphic User Interface (GUI) appears.

5.3.1 The MC32BC3770 GUI startup screen

Figure 11 shows the MC32BC3770 GUI Graphical User Interface (GUI) screen displayed at startup. A row of tabs along the top of the
screen selects among four types of control panel functions. (At startup the Control Register function is active.) The display related to the
selected function appears immediately below the row of tabs.

The USB Connection Panel at the top left of the screen verifies the GUI is properly connected to the target. It also controls certain
parameters related to the connection. For complete instructions on using the USB Connection Panel, see the video “01C - BC3770 GUI
Launch Video” in the FRDM-BC3770-EVB Product Summary page.

A Main Log in the middle left panel maintains a running record of all events occurring during the MC32BC3770 GUI session. For
instructions on using the Main Log, see the video “02 - BC3770 GUI Main Log Video” in the FRDM-BC3770-EVB Product Summary page.
The Direct 12C Communication Panel at the bottom left of the screen reads and writes bytes to the 12C registers. For complete instructions
on using the 12C Communication Panel, see the video“03 - BC3770 GUI I°C Communication Video” in the FRDM-BC3770-EVB Product
Summary page.
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P | Byte Read Byte Write | DO: Suspend Enabled | D3: Discharge Current Limit. - LOAD: (3) VSYS | VBAT
a n e Di: Battery Detect | D4: V5YS Overloaded [}
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Figure 11. GUI startup screen
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5.3.2 The control registers screen

Figure 12 shows the Control Register screen. The parameter control panel on the left manipulates system VBUS and charger control
parameters. It also controls events related to the MC32BC3770’s three interrupt registers. Finally, the panel at the bottom left provides a
snapshot of the MC32BC3770 status registers. For instructions on using the Control Register Panel, see the video “04 - BC3770 GUI
Control Registers Video” in the FRDM-BC3770-EVB Product Summary page.

The real-time system performance measurements panel on the right controls load sharing, battery supplement, and OTG boost functions
in real-time. Clicking on the Read System button at the bottom right updates the panel. If the Poll System check box is set, the panel
automatically updates on a periodic basis.

For a tutorial on using the Control Registers screen to support load sharing, see the video “08A - BC3770 GUI Load Sharing Video” in the
FRDM-BC3770-EVB Product Summary page.

For a tutorial on using the Control Registers screen to battery supplement, see the video “08B - BC3770 GUI Battery Supplement Video”
in the FRDM-BC3770-EVB Product Summary page.

For a tutorial on using the Control Registers screen to support OTG boost, see the video “08C - BC3770 GUI OTG Boost video” in the
FRDM-BC3770-EVB Product Summary page.

Parameter Real-Time
Controls Measurement

Control Registers | script Editor | Charge Plot | Discharge Plot |l i

SYSTEM CONTROL

OTG Boost Enable: Fl EVENT CLEAR MASK VBUS
Charger Enable: ] D0: Thermal Requlation Detect [ VBUS = 400V
Freseris F D1: Thermal Shutdown Detect [ TTSE0TTEn
Reset: ] D2: Battery OVP Detect [ [
T Ee e F D3: VBUS ILimit Detect ] ]
D4: AICL Threshold Detect [ [ VBUS
VBUS CONTROL DS: VBUS OK Detect ] [ BUCK
Dé&: VBUS UVLO Detect = = VEYS =419V
Input Current Limit: 500 * mA X Y & & 5 TS
D7: VBUS OVP Detect [ ]
CHARGER CONTROL
V5YS || p———
AutoStop Enable: EVENT O ‘lq:‘s
D0: Charger Topoff Started OFF ISYS = 0.001A
AICL Enable:
D1: Charger Done [ [ e
ALCL Threshold: =3 v Volts D2: Charger Restart Detect [ [
PreCharge Current: 450 * mA D3: Precharge Timeout [
Fast Charge Current: 500 ~ mA D+4: OTG Boost Fail Detect [
D5: Weak Battery Detect I:‘ IBAT = -0.001 A
Battery Regulation: 4,200 - Volts
Dé&: Battery Detect = =
Weak Battery Threshold: 3,60 ~ Volts D7: Fast Charge Timeout [F]
Topoff Current: 100 * mA + !
Disharge Current Limit: 4.0 * Amps EVENT CLEAR AS)
OTG Boost Vout: 5.0 - Volts DO: IDischarge Limit Detect ] YN@l vBAT=378V
IFast Timeout: OFF - R D1: VSYS Overload Detect (]
D2: VSYS Low Threshold Detect [ =
Topoff Timeout: 45 * Min JUMPER. 120 = [2-3]
D3: VSYS OK Detect =
ELOAD 1
ISET: 0 * MA

LOAD: (@ VSYS () VBAT

[ Poll System [ ] Read System

D0: Suspend Enabled D3: Discharge Current Limit

|
Statu S =P| o1:eattery Detect [ | D4: VSYS Overloaded
|

D2: Thermal Shutdown

Figure 12. Control register screen
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5.3.3 Script editor screen

The Script Editor tab loads and runs scripts automating the execution of Charger Control Panel commands. Figure 13 shows the Script

Editor screen.

The panel on the left is the script editor window. Enter commands directly into this window from the keyboard, or click on the Commands
button at the bottom of the window. Doing so opens a panel to select commands and enter values for their associated variables. These
commands automatically load into the editor in the sequence they were selected. Other buttons below this panel load, save, run, and clear

the script. The Insert Line Separator button enters a full line of dashes at the cursor location in the Script Editor.

The panel on the right shows a log of events occurring as the script executes. Buttons below this panel clears or saves the log. For
complete instructions on using the Script Editor panel, see the video “05 - BC3770 GUI Script Editor Video” in the FRDM-BC3770-EVB

Product Summary page.

Script Editor

Window

_Contral Registers | Script Editor | Charge Plot | Discharge Flot

File: Charger_Test.txt

Script Execution
Log

Script Log:

s

CHRRGER_EN:-OFF /4 Turn OFF charger
VBUS_ILIMIT_SET:1200 /4 Set VBUS current limit to 1500mR
SY5_POLLING:ON /¢ Enable Live Metering

s

IFRST_SET-100 /4 Bet Charge current to 100mk
CHARRGER_EN:ON /¢ Turn ON charger

DELAY:-100

LOG:VBAT:VSNS /# Read Battery woltage
LOG-VBAT:ISNS /¢ Read Charge current

PRUSE: // Wait for Continue Button
IFAST_SET:250 /¢ Set Charge current to Z50mA
DELAY¥:-100

LOG-VBAT-VSHS /4 Read Battery woltage
LOG:VBAT:ISNS /f Bead Charge current

PRUSE: /¢ Wait for Continue Button
IFRST_SET:500 /# Bet Charge current to 500mR
DETLAY-100

LOGE:VBAT:VSHS /¢ Read Battery woltage
LOG:VBAT:ISNS /¢ Read Charge current

PRUSE: /4 Wait for Continue Button
IFRST_SET:-750 /4 Bet Charge current to 750mk
DELAY:-100

LOG:VBAT:VSNS /¢ Read Battery wvoltage
LOG:VBAT:ISNS /¢ Read Charge current

PRUSE- /4 Wait for Continue Button

£

IFAST_SET:-500 /¢ Set Charge current to 500m&
WBUS_ILIMIT SET:500 /4 Set VBUS current limit to S500mA
CHRRGER_EN:-OFF /4 Turn OFF charger
5¥5_POLLING:OFF /¢ Disable Live Metering

Load Script I [ Save Saipt ] [Clear Saript ] [ Run Script

Insert Line Separator ]

[ Commands ]

Date: 2/25;"2-015 Time: 2Z2:4& lg{

Script File Used: C:\Users‘b3T70&3\Docum
Charger DISABLED

VBUS Ilimit = 1200 mi

Aetive Meters ENRELED

Fast Charge Current = 500 mh

Charger ENARELED

DELAY = 100msec

VBAT = 3.810 ¥

IBAT = 0.11Z A

Script PRUSED. Press [Continue] to proc
Fast Charge Current = 250 m&

DELAY = 100msec

VEAT = 3.831 ¥

IBAT = 0.264 &

Script PAUSED. Press [Continue] to proc
Fast Charge Current = 500 md

DELAY = 100msec

VBAT = 3.870 V

IBAT = 0.517 &

Script DAUSED. Press [Continue] to proc
Fast Charge Current = 750 mh

DELAY = 100msec

VBAT = 3.310 V

IBAT = 0.772 A

Script PRUSED. Press [Continue] to proc
Fast Charge Current = 500 mh

VBUS Ilimit = 500 mi

Charger DISABLED

Aetive Meters DISAELED

Script Run Complete

Save Saript Log Clear Script Log

Figure 13. Script editor screen
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5.3.4 Charge plot screen

The Charge Plot tab graphs voltage and current in real-time as the battery charges. Save the resulting plot data as an Excel file. Figure 14
shows the Charge Plot screen during a battery charging session. The panel on the upper left displays a log of events occurring during the
charging session. Clear or save the log by clicking the corresponding buttons below the log. The Charge Parameters panel controls the
current and voltage related to the battery charging session. The Plot Parameters panel controls the appearance of the graph. The Charge
State panel shows the current status of the charging session. It also starts, stops, clears, and saves the results of a battery charging

session.

Installing the software and setting up the hardware

For complete instructions on using the Charge Plot panel, see the video “06 - BC3770 GUI Charge Plots Video” in the FRDM-BC3770-EVB
Product Summary page.

Session
Log

% Charger Control Panel |
USB Connection | control Registers | sript Editor | Plots \ 4
VendorID:  0x15A2 Target: SM5418
S Battery Charge Cycle
Scan For Devices 4r 106
I A a
|
|
|
1 391
: —-0.55
|
! L . o .
1 sl -
|
1 = a
z = Hos
| I= 3 E
o 3 <
) | | 37|
|
1
|
| -045
| |
i L 36
I
|
|
|
1 15 . . . I . . . . 04
Terminated... 60 120 120 240 200 360 420 540 600
Time (sec)
—rm——— Charge Parameters Plot Parameters Charge State
12 Byte Read 12 Byte Write VBUS Current Limit: 500 mA SampingPeriod: 10w sec Battery Voltage: 3.893V |
Register: 0x00 Register: 0x00 Precharge Current: 450 mA V-Axis(max): 40 - I-Axis(max): 0.6 « Battery Current: 0.525A
Start
Data: 0x00 Data: 0x00 Fast Charge Current; 500 mA V-Axis(min): 35 v TAds(min): 0.4 v Total Samples: 61 Charge
Topoff Current: 100 ma V-Axis(tck): 01 v~ LAds(k): O6E - Charge Time: 600 sec
Battery Regulstion: 4,200 v [ store As Excel Fie ] [ cexr |
Buid: (Not Published) Quit

Figure 14. Charge plot screen

Freedom expansion boards FRDM-BC3770-EVB and FRDM-BC3770-EVM, Rev. 2.0

NXP Semiconductors

19


http://www.freescale.com/webapp/sps/site/prod_summary.jsp?code=FRDM-BC3770-EVB
http://www.freescale.com/webapp/sps/site/prod_summary.jsp?code=FRDM-BC3770-EVB

Installing the software and setting up the hardware

5.3.5 The discharge plot screen

The Discharge Plot tab graphs voltage and current in real-time as the battery discharges. Save the resulting plot data as an Excel file.
Figure 15 shows the Discharge Plot screen during a battery charging session. The panel on the upper left displays a log of events
occurring during the charging session. Clear or save the log by clicking the corresponding buttons below the log. The Discharge
Parameters panel controls the current and voltage related to the battery charging session. The Plot Parameters panel controls the
appearance of the graph. The Discharge State panel shows the current status of the discharging session. It also starts, stops, clears, and
saves the results of a battery charging session.

For complete instructions on using the Discharge Plot panel, see the video “07 - BC3770 GUI Discharge Plots Video” in the
FRDM-BC3770-EVB Product Summary page.

Session
Log

Freedom expansion boards FRDM-BC3770-EVB and FRDM-BC3770-EVM, Rev. 2.0

Figure 15. Discharge plot screen

Real-time
Plot
= - — ———
% MC32BC3770 Charger Control Panel =
USB Connection | Control Registers | Saipt Ecitor | Charge Plot | Discharge Plot \
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Scan For Devices ar
-
i 1028
H{-022
37
J-038
{04 g
@ @
I 344 a5 £
2 g
H-086
J-062
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-0.68
H-074
£ 28 | | I . L 1 L L . 08
- v 1=-0 - 0 204 528 882 1178 1470 1764 2058 2352 2646 2040
scharge Cy omplete Time (sec)
Save Log Clear Log 12C Address: 0x92
e Disharge Parameters Plot Parameters Discharge State
12 Byte Read 126 Byte Wiite VBUS CurrentLimit: 500 v mA Sampling Period: 10 v sec Battery Voltage: 2.994V |
Register: 0x00 Register: 0x00 Discharge Current: 500 ~ mA V-Axis(max): 40 - L-Axis(max): 0.2 = Battery Current: -0.500A
Datz: | 0x00 Data: 0x00 Termination Voltage:  3.000 v V V-Axdis(min): 28 v Ads(min): 0.8 v Totzl Samples: 296 msscfar:ge
[ ByeRead ] [ Byewite | V-Axis(ick): 03 - LAxis(i): 008 v Discharge Time: 2950 sec
[ swreasExcelfie | [ cear |
Build: (1.0.0.2)
Discharge Plot Discharge
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5.4 Configuring the hardware

Figure 16 shows the hardware setup using the FRDM-BC3770-EVB and the FRDM-KL25Z boards. For a tutorial on setting up the
FRDM-BC3770-EVB/FRDM-KL25Z platform, see the video “01B - BC3770 Battery Connections Video” in the FRDM-BC3770-EVB
Product Summary page.

Mini-USB Cable
(Power)

Lithium lon
Battery

'FRDM-BC3770-EVB —

—FRDM-BC3770-EVM

FRDM-KL25Z

Mini-USB Cable
(Communication)

Figure 16. FRDM-BC3770-EVM hardware configuration
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5.4.1 Step-by-step instructions for setting up the hardware

To perform the demonstration examples, the following connections and setup must be performed:

1. Mount the FRDM-BC3770-EVB board firmly to the Arduino connectors on the FRDM-KL25Z board. (If purchasing the
FRDM-BC3770-EVM kit, the boards are already mounted.)

2. Solder a wire lead to each pole of the Lithium lon battery.

3. Attach the Lithium lon leads to the two-pole terminal block (J8) on FRDM-BC3770-EVB. The negative lead goes to the inboard
connector. The positive lead goes to the outboard connector.
4. Connect the FRDM-BC3770-EVB board to a power supply. There are two methods of making this connection.

 Attach a USB mini-cable between the PC and the USB mini-plug connector on the FRDM-BC3770-EVB board. This draws
power from the PC via the USB port. However, because of the USB power supply is relatively low, the battery charges
more slowly.

» Cut the Standard-A plug off the USB cable. Identify and separate out the USB power lines in the cable. Attached the USB
power lines to a power source (either a power supply or a power adaptor.) Note that the source connected must supply
2.0 A current at 5.0 V. Attach the min-plug end of the cable to the USB port on the FRDM-BC3770-EVB board.

5. Attach a USB mini-cable between the PC and the USB communication port on the FRDM-KL25Z board. This cable serves as the
communication link between the Freedom platform and the PC.
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6 Using BC3770 components with Processor Expert
6.1 Installing CodeWarrior

This procedure explains how to obtain and install the latest version of CodeWarrior (version 10.6 in this guide).

NOTE
The sample software in this kit requires CodeWarrior 10.6 or newer. The component and some
examples in the component package are intended for Kinetis Design Studio 3.0.0. If CodeWarrior 10.6
and Kinetis Design Studio 3.0.0 are already installed on the system, skip this section.

1. Obtain the latest CodeWarrior installer file from the NXP CodeWarrior website here:
www.nxp.com/webapp/sps/site/homepage.jsp?code=CW_HOME&tid=vanCODEWARRIOR.

2. Run the executable file and follow the instructions.

3. In the Choose Components window, select the Kinetis component and click on Next to complete the installation.

(

-
~* CodeWarrior Development Studio for Microcontrollers v10.6 Setup ELId_hJ
Choose Components -

>
Choose which features of CodeWarrior Development Studio for Microcontrollers v10.6 ~ «= +*
you want to install. e

Check the components you want to install and uncheck the components you don't want to
install. Click Next to continue.

Select components toinstall: | [7] coldFire/Sensors
>

[Js12z
[[]so8/rs08

Description

Space required: 1.4GB

[ < Back ][ Next > ] [ Cancel

Figure 17. Choose components window
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6.2 Downloading the components and example projects

The examples used in this section are based on a pre-configured CodeWarrior project. To download the project and its associated

components:

1. Go to the NXP website www.npx.com/BC3770-PEXPERT

2. Download the zip file containing components and example projects.

3. Unzip the downloaded file and check to see the folder contains the files listed in Table 7.

Table 7. BC3770 example project and components

Folder name

Folder contents

Components

Component folder

BC_MC32BC3770_b15xx.PEupd

Battery charger BC3770 component

FRDM_BC3770_b15xx.PEupd

Freedom board FRDM-BC3770 component

ChannelAllocator_b15xx.PEupd

Component for ADC channel allocation

Examples

Battery_Charger_BC3770_Control

Folder containing application files used in BCF_KLxxZ_Battery_Charger_BC3770_Control_Usb_Hid exam-
ple

CodeWarrior_Examples

Example project folder for CodeWarrior

BCF_KL25Z_BC3770_GUI_Usb_Hid

Example with BC3770_GUI for FRDM-KL25Z

BCF_KLxxZ_Battery_Charger_BC3770
_Control_Usb_Hid

Example showing usage of BC_MC32BC3770 and FRDM_BC3770 methods with
Battery_Charger_BC3770_Control application for FRDM-KL25Z, FRDM-KL26Z and FRDM-KL46Z (where
xx is the MCU)

BCF_KLxxZ_Monitoring_CDC

KDS_Examples

Example project folder for Kinetis Design Studio 3.0.0 or newer

BCF_KL25Z_BC3770_GUI_Usb_Hid

Example with BC3770_GUI for FRDM-KL25Z

BCF_KL25Z_Battery_Charger_BC3770
_Control_Usb_Hid_IAR

Example showing usage of BC_MC32BC3770 and FRDM_BC3770 methods with
Battery_Charger_BC3770_Control application for FRDM-KL25Z and IAR Embedded Workbench.

BCF_KLxxZ_Battery_Charger_BC3770
_Control_Usb_Hid

Example showing usage of BC_MC32BC3770 and FRDM_BC3770 methods with
Battery_Charger_BC3770_Control application for FRDM-KL25Z, FRDM-KL26Z and FRDM-KL46Z (where
xx is the MCU)

BCF_KLxxZ_Monitoring_CDC

Example showing current, voltage and temperature measurement with output to terminal for FRDM-KL25Z,
FRDM-KL26Z and FRDM-KL46Z

Readme.pdf

Read me file with installation instructions.
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Import the BC3770 components into the Processor Expert library

1. Launch CodeWarrior by clicking on the CodeWarrior icon (located on the desktop or in Program Files -> NXP CodeWarrior folder.)
When the CodeWarrior IDE opens, go to the menu bar and click Processor Expert -> Import Component(s).

2. In the pop-up window, locate the component file (.PEupd) in the Components and Example Projects folder

BC3770_PEx_SW\Component. Select BC_MC32BC3770_bxxxx.PEupd, FRDM_BC3770_bxxxx.PEupd, and
ChannelAllocator_bxxxx.PEupd files then click Open (see Figure 18).

3 -
¥ ¢/C++ - CodeWarrior Development Studio

-

oo e |

LI

Bg CodeWar... 52

File Name

< i

£3 Comman... §2

¥ Project Creation
223 Import project
£ Import example
223 Import MCU ex
% New MCU proje
F% New MQX-Lite

< [

7 (Active)

v |

File Edit Source Refactor Search Project MQXTools |Processor Expert| Run Window Help

<R £~

Show Views

Hide Views 5 | [Eocs
Import Comp <%
=B =B
[Ee=)
@Qvl <« BC3770 » BC3770_PExSW » BC3770_PEx SW » Component < [4,“ Search Component ol
Organize v New folder =~ Al @
¢ Favorls Documents library Arrange by:  Folder ~
B Desktop Component
Q Downloads Fame
21 Folder

£ livelink-func=Il&objld=2
| Recent Places

m

4 Libraries
<] Documents
& Music
[ Pictures
B videos

1™ Computer
& Primary (C)
& Compass (\\azB4file24v)

Date modified

|| BC_MC32BC3770_b1501.PEupd
_| ChannelAllocator_b1508.PEupd
|_| FRDM_BC3770_b1501.PEupd

9/25/2015 7:57 AM
7/7/2015 1:25 AM
10/6/2015 1:14 AM

.

File name: "FRDM_BC3770_b1501.PEupd" "BC_MC32BC3770_b1SOLPEu ~

»

Coow

Figure 18. Import the BC3770 components

3. If the import is successful, the BC3770 and FRDM_BC3770 component appears in Components Library -> SW -> User
Component (see Figure 19). Note that the component ChannelAllocator is hidden and is not accessible to users. This

component is used by the BC3770 components only.
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| @ Hardware - CodeWarrior Development, Studio lglﬂu

File Edit Search Project MQXTools ProcessorExpert Run Window Help

<j v ;-"- v % v Q’-‘ b
Ny K] v v | o

Quick Access §_5{| Bg c/c++
%y Component Inspector £y Components Library 52 Eif @ Y =0

Categorie;-’ ».,V_I}Iphabetical. ] Assistant-l Processors ‘

Component Component Level -
b (= CPU External Devici L

> (& Logical Device Driv
b (= Operating Systems
4 (= Software
4 (= User Componer
@B BC_MC32BC High
FRDM_BC37 High

n P QM

m

No project focused, filtering disabled

[21 Problems 52 B Y=08
0 items
Descriotion 2 Resource Path

&

> (= CPU Internal Peripk |

Figure 19. BC3770 components location after CodeWarrior Import

The BC3770 components are ready to use.
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6.2.2 Importing an example project into the Processor Expert library

The following steps show how to import an example from the downloaded zip file into CodeWarrior.

1.1n the CodeWarrior menu bar, click File -> Import... In the pop-up window, select General -> Existing Projects into Workspace
and click Next.

¥ C/C++ - CodeWarrior Development Studio EM
—> Edit Source Refactor Search Project MQXTools Processor Expert Run
1
New Alt+Shift+N »
Open Path... Ctisshifted | Z 7 TR
Open File... ick Access 121 [ C/C++
Close Ciro § Components Library 2 = d
Close All Ctrl+Shift+W }@ Import | B | -
1+
Sove CHlss Assistant | Pi | Select \
Save As... . o X P |
Create new projects from an archive file or directory. E 5
Save All Ctrl+Shift+S
Revert 3
Select an import source:
Move... -
Rename... F2 type fiter text
& Refresh F5 4 (= General < =
Convert Line Delimiters To v @A ArAch‘lve F'Ie' .
= Existing Projects into Workspace | e
Print... Ctrl+p  onstration: (), File System
Switch Work > F =, Preferences
witch Workspace
2 = C/C++
Retart (= CodeWarrior 3
3 [y Import.. disabled (> Component Development Environment
o = Cvs
(= Install
Properties Alt+Enter (= Processor Expert
T (= Run/Debug
. (= Software Analysis L
= Team
v (5. Other =
® <bece | mmbicamny [ Frih
A
4

Figure 20. Importing an example file (a)

2. Click Browse and locate the folder where you unzipped the downloaded example files. Find the folder
BC3770_PEx_SW\Examples\CodeWarrior_Examples and select a project to import. (see Figure 21, which shows
BCF_KL25A_Battery_Charger_BC3770_Control_Usb_Hid as the imported project). Then click OK.
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”
¥ Import B %
Import Projects —
Select a directory to search for existing Eclipse projects. 4
@ Select root directory: e
(©) Select archive file: g Ll Browse L
Projects: Browse For Folder [} @
Select root directory of the projects to import
. OxygenXMLAuthor &

> 1 Playpen-LK
4 || Processor Expert
4 |, BC3770
4 | BC3770_PEx_SW
4 |, BC3770_PEx_SW

|, Component

[] Copy projects inf|
s 4 |, Examples

J Battery_Charger_BC3770_Control
[T] Add project to{) 4 |, CodeWarrior_Examples
Warking set - . BCF_KL25Z BC3770_GUI Usb_Hid| -
b . BCF_KbLxodZ_Battery_Charger_BC3770_Control_Usb_Hid
BCF_KbLxoZ_Monitoring_CDC

Working sets

m

. KDS_Examples
. Example Files
@ . LVHB
. MVHB S
Se—

Folder:  BCF_KL257_BC3770_GUI_Usb_Hid

o]
A

Figure 21. Importing an example file (b)

3. With your project now loaded in the Select root directory box, click on the Copy projects into workspace check box. Then click
Finish. Figure 22 shows the CodeWarrior Projects panel and the Components panel after the project has been successfully

imported.

The project is now in the CodeWarrior workspace where you can build and run it.
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Import Projects
Select a directory to search for existing Eclipsg projects.

rﬁi Import M
=

@ Select root directory:  C:\Users\b54064\Ddcuments\Processor Expert\

() Select archive file: Browse...

Projects: -
BCF_KL25Z_BC3770_GUL Usb_Hid (CA\[lsers\b54068\Documents\F 9 Hardware - CodeWarrior Development Studio

File Edit Search Project MQXTools Processc

57

=] | &~

[ Project Explorer §2 B& Y =08

P e T— »
e ; <
B Gogy projects mieo wodtepace I » 5= BCF_KL25Z_BC3770_GUI_Usb_Hid <
Working sets
[7] Add project to working sets 5. Components - BCF KL25Z B... 52 = O
Warking sets: - El G b -
4 (= Generator_Configurations
# FLASH
p (= OSs
@ < Back Next > Finish 4 (= Processors
[ﬁ > &8 Cpu:MKL25Z128VLK4 <

4 (= Components
> (= Referenced_Components
» €8 USB_LDD:USB_LDD
» (@8 BCFL:FRDM_BC3770

» (= PDD

0 items selected

T — — = )

Figure 22. Importing an example file (c)
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6.3 Creating a new project with Processor Expert and the BC3770

components

If you choose not to use the example projects, the following instructions describe how to create and setup a new project using the BC3770
components. If you do not have the BC3770 components in the Processor Expert Library, please follow steps in Section 6.2.1, Import the
BC3770 components into the Processor Expert library, page 25.

To create a new project do the following:

1. In the CodeWarrior menu bar, select File -> New -> Bareboard Project. When the New Bareboard Project dialog box opens,
enter a project name into the text box and then click Next. (see Figure 23).

/C+} - CodeWarrior Development Studio el —

New
Open Path...
Open File...

Close

Close All

Save
Save As.
Save All
Revert
Move..

Rename...

Refresh

Convert Line Delimiters To

Print...

Switch Workspace
Restart

g2y Import...
ey Export..

Properties

Exit

Figure 23. Creating an MCU Bare-board Project

ﬁe g'z Source Refactor Search Project MQX Tools Prodessor Expert Run Window Help

Alt+Shift+N » | ¥ Linux/uCfinux Application Project
Ctrl+Shift+A | ¥3  MQX-LityProject

¥3  Bareboard Project

CtrleW ) Embedded Component

Ctrl+Shift+W | €% Makefile Project with Existing Code

CtrlS Y Project...

¥ New Bareboard Project of X
a
Create an MCU Bareboard Projectl}

Choose the location for the new project

Project name:  My_Project <

[¥] Use default location

C:\Users\b54064\workspaceBC3770-1\My_Project Bro
=
A

2.In the Devices dialog box, select the MCU class for the appropriate MCU (In Figure 24, MKL25Z128 has been selected). Then

click Next.

3.In the Connections dialog box, select the type of connection the project uses. (In Figure 24 P&E USB Multilink Universal
[FX]/USB MultiLink has been selected). Then click Next.
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New Bareboard Project

Using BC3770 components with Processor Expert

Devices

Device or board to be used:

type filter text

Select the derivative or board you would like to use

> Kinetis E Series
i Kinetis K Series
4 Kinetis L Series
i KLOx Family
> KL1x Family
4 KL2x Family
> KL24Z (48 MHz) Family
4 KL25Z (48 MHz) Family
MKL25Z32
MKL25Z64

» MKL25Z128
. KL26Z (48 MHz) Family

A~

-
¥ New Bareboard Project

Connections

Connection to be used:

[T] P&E Cyclone
[7] P&E TraceLink
[7] Open Source JTAG

Project Type / Output:
@ Application
© Library

OpenSDA

Creates project for MKL25Z128 (48 Mhz) derivat| I

Choose the connection to use for this project

[] Segger J-Link / J-Trace / SWO (SWD based)

P&E USB MultiLink Universal [FX] / USB MultiLink g

'| Connect to P&E USB MultiLink Universal [FX] / USB MultiLink.

Y

@ [ < Back ]E

Next >

1

Einish

J|

Cancel

4.In the Language and Build Tools Options dialog box, select the options for the project. (In Figure 25, the default options are

Figure 24. Selecting a device and a connection

selected.) Then click Next.

5.In the Rapid Application Development dialog box, make sure the Processor Expert button is selected. Then click Finish
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-
¥ New Bareboard Projfct

Elg

Language and BuiIdITooIs Options

~ B

-
¥2 New Bareboard Project 9 =&

Language:
@C
© C++

© ASM

Floating Point:
@ Software
Hardware (-mfloat-abi=hard) vs. (-fp vfpv
Hardware (-mfloat-abi=softfp)

o

Hardware (-mfloat-abi=softfp -fshort-doy

/O Support:
@ UART (default)
() Debugger Console
@) Nol/O

ARM Build Tools:
@ GCC

Freescale

C language support will be included in the project.
Software floating point support will be included in

UART support will be included in the project.

Rapid Application Development

Processor Expert

>

Rapid Application Development

|

Start with perspective designed for
() Hardware configuration (pin muxing and device initialization)

@) Use current perspective

m

Initialize all peripherals

| Project Mode
@ Linked

() Standalone

Processor Expert can generate for you all the device initialization code.  »
It includes many low-level drivers.

@ Next > [ Finish ] [ Cancel

A

@ [ < Back ” Next > ] [

Figure 25. Selecting the language, build tools, and the rapid application development options

6. Figure 26 shows the CodeWarrior Projects panel and the Components panel after the project has been successfully created.

Before the project can be built and run, add the component (imported in Section 6.2.2, Importing an example project into the Processor
Expert library, page 27) into the project. Section 6.3.1, Adding a BC3770 component into the project, page 34 outlines this procedure.
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X@ Hardware - CodeWarrior Development Studio o|B@ =
File Edit Search Project MQXTools ProcessorExpert Run Window Help
i | |~ & 3 v P v 5] v % - v| =
Quick Access B | %C/C*ﬁ
[P Project Explorer £3 = [m 8y Co specto %)y Components Library 52 = O
, 8% (D -
»| =5 My Project |
€ i Alphabetical | Assistant | Processors
5. Components - My Proj... 82 = B
- Component Component Leve
SRR > (= Board Support
4 (= Generator_Configurations b (& CPU External Devices
o . ﬁ' FLASH [ (= CPU Internal Peripherals
- @ 0ss b (= Logical Device Drivers
4 (= Processors b (= Operating Systems
> 49 Cpu:MKL25Z128VLK4 4 & Softwar
» (& Components 4 (= Userlomponents
> & PDD @ BC_MC328C3770 High
@ FRDM_BC3770 High
> & SW
< m ] »
Filter on for MKL25Z128VLK4 (My Project)
=5 My Project &

Figure 26. CodeWarrior projects and components panels with project created
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6.3.1

Adding a BC3770 component into the project

1.Find the BC3770 component in the Components Library and add it into the project (see Figure 27).

¥ Hardware - CodefVarrior Development Studio

=)

i [ A

[ Project Explored 52 BEgE Y= O
. £ BCF KL25WBC3770_GUI Usb_Hid
=% My_Project

%5 Compenents - My_Project 53 = 08

File Edit Search| Project MQXTools ProcessorExpert Run Window Help

e A L~

Quick Access

% Component Inspector % Components Library £3 = =

Categories _Alphabetlcal\f Assistant | Processors |

Component

. (= Board Support
» = CPU External Devices

> [ CPUInternal Peripherals

» (= Logical Device Drivers
> (= Operating Systems
4 = Software

b G SW

Filter on for MKL257138VLK4 (BCF_|

| e (ST

2@ -

Component Level

a P User Components
>| @

BC_MC32BC3770

G| @ Addto project <€

Add to project with Wizard

Expand all

Collapse all
&1 Refresh F5
# Delete Delete

Help on Component

Profile As

Resource Configurations

Figure 27. Add the BC3770 component to the project

2. Figure 28 shows the Components panel after the component was added. To view the Component Inspector options, double click
on the BC3770 component in the Components panel.

B, Referenced_Components

BB BCFL:FRDM_BC3770
» = PDD

P > B BCLEC MG ey
>

N
5 Hardware - CodeWarrior Development Studio =
File Edit Search Project MQXTools ProcessorExpert Run Window Help
NB-HGIS-& By v w2
Quick Access B | @ crces
[ Project Explorer 52 2% T = B %) “ComponentInspector- BCL 53 | £ Components Library =8
« -
> B> My Project [Basic JAdvanced @ ¥
Properties .. Methods | Events
. Components - M{@roject 3 =8 o) akue Detaile =
o Component Name BC1
SRR ] 4 General Settings F
4 (> Generator_Configurations Charger Ensbled .
B FLASH Suspend Mode no
> & 0Ss Comparator Enabled yes
4 ( Processors Shutdown Enabled no
P CpuMKL2SZI28VLKS OTG Enabled no
4B Components 4 Control Pins Enabled

CHGEN Enable Pin
SHDN Shutdown Pin
4 12C Communication
12C Link
4 VBUS Control
4 AICL on VBUS

PTEO/UART1_TX/RTC_CLKOUT/...
PTEL/SPIL_MOSI/UARTL_RX/SPL.

aa

Enabled

< il

Figure 28. Select the component
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6.3.2 General component inspector view for the BC3770 components

The Component Inspector view provides a means of accessing and modifying component properties. When CodeWarrior is set to the
Classic view, properties in the Component Inspector are arranged in a collapsible tree-structure. Property names appear in the Name
column. The Values column lists the current value assigned to the property. Values not greyed-out in this column may be modified. The
Details column contains additional information (including error conditions) about the selected property. (If CodeWarrior preferences are
set to the Tab view, properties are arranged differently in the Component Inspector; However, the same definitions apply.)

CodeWarrior provides on-screen help for events, methods, and properties. To view a brief description of a method or an event, hover the
mouse pointer over the respective item in the Components panel. A pop-up with a brief description of the item appears (see Figure 29.)
The same technique applies for component events, methods, and properties in Component Inspector view.

¥ Hardware - CodeWarrior Development Studio, = el BN
File Edt Search Project MQXTools ProcessorExpert Run Window Help
BERI% -6 B P B-G-wa-oe| Quick Acees | B
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€ BCFKL25Z Bty Charger BT Coneol U bid [, e
=5 BCF_K1L25Z_BC3770_GUIUsb_Hid roperties ethods | Events
425 BCF_KL26Z_Battery_Charger BC3770_Control Usb_Hid | | Neme Value Details
15 BCF KLIGZ Battery_Charger, BC3770_Control Usb, Hid T T 81
125 My Project 4 GenerslSettings
Charger Enabled yes
Suspend Mode no
. Components - My Project 57 [ 3 @ 7 = O Comparator Enzbled ves
. enerstor Confiounat Shutdown Ensbled no
‘ d?;":;«;: enfiguretions OTG Enabled no
2 4 ControlPins Ensbled
ey CHGEN Link 8iti0_LDD
e A CHGEN Enable Pin TSI_CH2/PTAL/UARTO_RK/TPM2_CHO
4 = Component
L SHON Link Bit0_LOD
S St Qoo b A SHDN Shutdown Pin TSI CH3/PTA2/UARTO_TX/TPM2_CHL
“ o 4 2CCommunicati
) CHGENPin:Bit0_LDD e eaten wer
&8 SHONPin1:itio_LDD . VBUS Control
g PLEALOD 4 AlcLonVBUS Enabled
gk"“dk er AICL Threshold [V] 45
i Input Current Limit [mA] 500 1B Note! Input value is rounded to 500 |
) WiteRegister 4 Charger Control I
¥ Wiie]This method reads data from muftiple register via 2C.
5 Setin| The first porameter is an adressof the frstrea regite.
0 Crns| Adiesses offollowingregiters e ncrementd automatialy 50
'¢3]  incoming bytes of data are content of consecutive registers.
H EnDis| 1pp TError BC1_ReadBurstData(TRegisterAddress Reghddr, uintg_v* DataPtr, uinté_t
A Reset| usyces) ;. | Note! Input value i rounded to
) SetCh -Retum value: error code, ERR_OK if successful Note! Input val dedto 500
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8 segd 2 Parameter pointer to memory wherencoming data il be sored
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Figure 29. Component on-screen help feature

To view on-line documentation for a component, right click on the component in the Components panel. In the pop-up menu, click Help
on Component (see Figure 30.)
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Figure 30. Component on-line help feature
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6.4 BC_MC32BC3770 and FRDM_BC3770 Processor Expert components

FRDM_BC3770 and BC_MC32BC3770 Processor Expert components are software drivers which encapsulate the functionality of the
MC32BC3770CS battery charger device and its companion evaluation board, the FRDM-BC3770-EVB. These components provide an
API layer between the hardware and the user application. The BC3770 components make application development less time consuming
by offering an easy to use interface allowing the user to set options for charging parameters, register settings, measurements, and testing.
The BC_MC32BC3770 component contains MC32BC3770CS battery charger methods allowing the user to set charger modes, interrupts,
and charging parameters. The FRDM_BC3770 component encapsulates all the functionality of the FRDM-BC3770-EVB Freedom board.
It contains methods for current, voltage, and temperature measurement. This component uses Current Sense Amplifiers, enabling current
and voltage sensing on the power supply (VBUS), the battery charger output (VSYS), and the battery (VBAT). FRDM_BC3770 component
methods also offer electronic load settings making it possible to test user applications in real time.

6.41 The BC_MC32BC3770 Processor Expert Component

This section summarizes main features of BC_MC32BC3770 component and provides an overview of the properties appearing in the
Component Inspector view. Table 8 lists all of the methods and events related to the component. Figure 31 shows typical Component
Inspector properties for a project using the BC_MC32BC3770 component.

£y *Component Inspector - BC1 52 |8y Components Library Basic @ Y =0
Properties “_Methods | Events
Name Value Details =
Component Name BC1
4 General Settings
Charger Enabled yes
Suspend Mode no
Comparator Enabled yes
Shutdown Enabled no
OTG Enabled no
a Control Pins Enabled
CHGEN Link BitIO_LDD
A CHGEN Enable Pin TSI0_CH2/PTA1/UARTO_RX/TPM2_CHO =
SHDN Link BitIO_LDD
A SHDN Shutdown Pin TSI0_CH3/PTA2/UARTO_TX/TPM2_CH1
a 12C Communication
12C Link CRC2
a VBUS Control
4 AICL on VBUS Enabled
AICL Threshold [V] 45
Input Current Limit [mA] 500 DI Note! Input value is rounded to 500
4 Charger Control
Auto Stop Enabled
OTG Boost Voltage [V] 5.0
Battery Regulation [V] 4.200
Weak Battery Threshold [V] 3.60
Precharge Current [mA] 450
Fast Charge Current [mA] 500 DI Note! Input value is rounded to 500
Topoff Current [mA] 100
Discharge Current Limit [A] 4.0
Ifast Timeout [h] 0.0
Topoff Timeout [min] 45
4 Interrupts Enabled
INT Link ExtInt_LDD
A INT Interrupt Pin PTDO/SPI0_PCS0/TPMO_CHO
Thermal Regulation Disabled -
< m »

Figure 31. Component inspector view - BC_MC32BC3770
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Component properties are grouped into five main sections: General Settings, I2C Communication, VBUS Control, Charger Control,
and Interrupts.

General Settings encompasses charger mode settings. When the Charger Enabled property is set to No, the battery charger is disabled
and the battery is not charged. However, other circuits and blocks (I2C, AICL, etc.) remain fully functional. If the Charger Enabled property
is set to Yes, the battery charger either charges the battery or maintains constant voltage on the battery, if it is fully charged. In Suspend
mode, PMID output is bypassed to VBUS, meaning the charger does not affect output voltage or current. In Boost (OTG Enabled) mode
the device provides a regulated output voltage to VBUS from the battery. In Shutdown Enabled mode, if there is no valid input source,
the charger remains functional except for the 12C interface, which is turned off to minimize power consumption. Setting the Shutdown
Enabled mode is not effective as long as a valid input source is present.

I2C Communication allows the selection of linked 12C_LDD components which are used for communication with the battery charger.

VBUS Control contains options for settings the Adaptive-Input Current Limit (AICL) feature of the battery charger. This feature is useful
when the current and voltage power supply is limited. Under such circumstances, AICL prevents the power supply from collapsing when
the required input current exceeds the maximum output current of the supply. The battery charger in Start-up mode automatically starts
incrementing the input current limit to either the default or the pre-programmed value until either the input current limit (IIN_LIM) is detected
or the VBUS voltage (VAICL_TH) detects the AICL threshold (see Figure 32). If the input current exceeds the power supply current limit,
the AICL function takes over and lowers the charge current below the programmed value. See the battery charger data sheet for more
information.

VBUSIN
VaicL_TH |
\
lin_um |
‘ I
‘ [ |
‘ 1
‘ I
|
| } } OTP-Programmable
Soft Start Clock Period
IN_Lim ‘ [
‘ | I
|
\
| \
INUWM | — — — — — — ———————————————————————— — — — — — — — -
I
IcHg+sys
VBATREG | — — — — — — — — — — — — —

Var — _

Figure 32. Adaptive-input current limit

The Charger Control section contains charging parameter options. Auto Stop controls battery charger behavior after the charging
process is finished. When Auto Stop is enabled, the battery charger turns off and goes into the DONE state when the Topoff timer expires
(i.e. the charging process is finished). Otherwise, the battery charger remains on continuously and stays in Constant Voltage mode after
charging, which means it maintains a certain voltage level on the battery. This section also contains options for current settings in current
settings in Pre-charge, Fast charge, and Top-off mode. Note that you cannot switch between these modes. The battery charger
continually transits from one mode to the next based on the battery voltage. IFast Timeout [h] and Topoff Timeout [min] are safety
timers. If the battery voltage does not reach a certain voltage threshold before the timer expires, charging is suspended and a fault signal
is asserted.

Freedom expansion boards FRDM-BC3770-EVB and FRDM-BC3770-EVM, Rev. 2.0

NXP Semiconductors 37



Using BC3770 components with Processor Expert

Battery Regulation [V] sets the voltage maintained on the battery when the battery charger is on (Auto Stop is disabled) and the battery
is fully charged. If the battery charger is off after charging, the battery voltage decreases until it reaches the Weak Battery Threshold [V]
value, at which point an interrupt is asserted. For more information please see the MC32BC3770 battery charger data sheet.

6.4.1.1

BC_MC32BC3770 component API

Table 8 describes all of the public Methods and Events related to the BC_MC32BC3770 component. Component Methods are also listed
in the Components panel, as depicted in Figure 33. Methods and Events marked with green check marks are included when source code
is generated; Methods and Events marked with black crosses are not included (see Figure 33). To change these settings, go to the
Component Inspector panel and select the Methods tab (see Figure 34). Note that some of Methods/Events are always generated

because they are needed for proper functionality.
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- & CpuMKL25Z128VLKY
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- 1 CCLRC_LDD
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%J CHGENPinl:BitIO_LDD
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M Init

M ReadRegister

H WriteRegister

] ReadBurstData

M WriteBurstData

H Setlnterrupt

M Clearnterrupt

M EnDisComparators

] Reset

H SetChargerMode

| EnDisShutdown

H SetAICLCurrentlimit

] SetAICLVoltageThresheld
[ EnDisAICL

M SetPreChargeCurrent

M SetTopOffCurrent

M SetFastChargeCurrent
M SetDischargeCurrent

H EnDisAutostop

] SetWeakBatteryThreshold
M SetBatteryRegulationThreshold
H SetBoostOTGVeltage

] SetFastChargeTimer
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. (= PDD

_\9.@ v:E

-

Figure 33. BC_MC32BC3770 methods in the components panel
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Basic | = S|

% Component Inspector - BC1 &3

Properties Metheds . Events

MName Value Details
Init generate code
ReadRegister
WriteRegister
ReadBurstData
WriteBurstData
SetInterrupt
ClearInterrupt
EnDisComparators
Reset generate code
SetChargerMode generate code
EnDisShutdown generate code
SetAICLCurrentlimit generate code
SetAICLVeltageThreshold generate code
EnDisAICL generate code
SetPreChargeCurrent generate code
SetTopOffCurrent generate code
SetFastChargeCurrent generate code
SetDischargeCurrent generate code
EnDisAutostop generate code
SetWeakBatteryThreshold generate code
SetBatteryRegulationThreshold generate code
SetBoostOTGVeltage generate code
SetFastChargeTimer generate code
SetTopOffTimer generate code
GetStatus generate code

generate code
generate code
generate code

4 1 b

Figure 34. BC_MC32BC3770 generated methods

Table 8. BC_MC32BC3770 methods and events

Methods/events Description
Initializes the device according to the component properties. This method writes data according to the component properties
Init into registers via I2C. When auto initialization is enabled, this method is called automatically within the PE initialization func-
tion - PE_low_level_init().
Reads data from a single register defined by RegAddr argument. If the method returns ERR_OK, it doesn't necessarily mean
ReadRegister the reception was successful. The actual state of the reception is detectable by means of events (OnMasterSendComplete
or OnError).
WriteRegister Writes data to a single register defined by RegAddr argument.
This method reads data from multiple registers via 12C. The first parameter is an address of the first read register. Addresses
ReadBurstData . - ) ? ) ) 4 )
of following registers increment automatically, so incoming bytes of data represent the content of consecutive registers.
This method writes data to multiple registers via I2C. The first parameter is an address of the first register to be written.
WriteBurstData Addresses of following registers increment automatically, so out coming data is written to consecutive registers automati-
cally
Setlnterrupt Enables or disables an interrupt. Interrupts can be set either individually or all at once. It is not possible to set, for example,

two interrupts at once.

Clearinterrupt

Clears interrupt flags in INT1...3 register. Interrupt flags can be cleared either individually or all at once. It is not possible to
clear, for example, two interrupts.

EnDisComparators

This method enables/disables comparators enabled by default. The comparators detect weak battery, supply voltage status,
battery OVP, and discharge limit.

Reset This method resets the device's registers, except INTMASK and STATUS.
This method sets Charger mode. The charger can be on or off. When the charger is on, it charges the battery or maintains
constant voltage on the battery. In Suspend mode, the PMID output is bypassed to VBUS, which means the charger does
SetChargerMode not influence output voltage and current. In Boost mode, the device provides a regulated output voltage to VBUS from the

battery. In Shutdown mode, if there is not valid input source, the charger is functional except for the 1“C interface, which is
turned off to minimize power consumption. The device enters Charge mode when a valid input source is present.
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Table 8. BC_MC32BC3770 methods and events

Methods/events Description
Enables/disables the shutdown pin, which means the device is put in Shutdown mode. In Shutdown mode the IC interface
EnDisShutdown is turned off to minimize power consumption. However, this applies only in case of an invalid input power source. This pin is
not effective as long as a valid input power source is present.
Fast charge timer watches the device during Fast-charge mode. An interrupt is asserted if the battery voltage does not reach
SetFastChargeTimer its required value within this “fast-charge” time frame. Possible values are 3.5, 4.5, and 5.5 hours, or the timer can be dis-
abled.
SetTopOffTimer Top-off timer watches the device during Top-off mode. An interrupt is asserted if the battery voltage does not reach its
P required value within this “top-off” time frame. Possible values are: 10, 20, 30, or 45 minutes.
GetStatus This method returns the content of the status register.
Pre-charge current is current charging the battery in pre-charge mode. The battery charger enters Pre-charge mode when
SetPreChargeCurrent battery voltage is higher than 2.5 V. If the battery voltage does not exceed the VSYS_MIN threshold before the pre-charge
timer expires, charging is suspended and a fault signal is asserted via the INTB pin.
Fast-charge current is current charging the battery in Fast-charge mode. The Fast-charge mode is entered when the battery
SetFastChargeCurrent voltage exceeds the VSYS_MIN threshold of a typical 3.6 V. If the battery voltage does not reach the VBAT_REG threshold
before the timer expires, charging is suspended and a fault signal is asserted via the INTB pin.
Top-off-charge current is current charging the battery in Top-off mode. After the top-off timer expires, the top-off event is
SetTopOffCurrent reported to the processor via the INTB pin, which means the battery is fully charged. As soon as the processor reads the

interrupt registers, the processor is able to turn off the charger.

SetDischargeCurrent

This method sets the discharge current limit in Discharge mode.

Based on this threshold, the charger transits from Fast-charge mode (Constant-current mode) to Full-charge mode (Con-

?E';E:;t;rg/Regulanon stant-voltage mode). In Full-charge mode, the fast charge current is reduced to a programmable top-off current. Up to this
threshold the VSYS output tracks the battery voltage in Trickle and Pre-charge mode.
SetWeakBattery This method sets the weak battery threshold voltage. The threshold ranges from 3.0 V to 3.75 V in 50 mV steps. A weak bat-
Threshold tery detection function allows the processor to acknowledge the low-battery condition by asserting an INTB event.
SetBoostOTGVoltage This method sets OTG voltage in Boost (OTG) mode. In Boost mode the device provides a regulated output voltage to
VBUS from the battery.
This method enables or disables the autostop feature. If autostop is enabled after the top-off timer expires, the charger turns
EnDisAutostop off and goes into DONE state. If it is disabled, the charger is on continuously and stays in CV mode after the top-off timer is
expires.
Enables/disables adaptive-input current limit (AICL). AICL is mostly used at the beginning of the charging process when cur-
EnDisAICL rent dissipation is higher than the current the power source can provide. This feature prevents the power source from col-
lapsing.
This method sets AICL threshold voltage on VBUS. To keep the device functional with a current and voltage limited VBUS
SetAICLVoltage source, the device in Start-up mode automatically starts incrementing the input current limit to either the default or pre-pro-
Threshold 9 grammed value until either the input current limit is detected or the VBUS voltage detects the AICL threshold. This keeps
input supply voltage as a valid power source to provide the load for the application. The device allows the maximum current
the input supply can possibly provide without severely collapsing.
This method sets the input current limit by writing to VBUSCTRL register. This value limits the fast-charge current when the
device is in Fast-charge mode. It also sets the limit for the adaptive-input current limit (AICL) when a device in Start-up mode
SetAICLCurrentLimit automatically starts incrementing the input current limit to either the default or pre-programmed value until either the input

current limit is detected or the VBUS voltage detects the AICL threshold. This keeps input supply voltage as a valid power
source to provide the load for the application.

Onlnterrupt

Interrupt event handler from battery charger. This event is invoked every time there is a falling edge on the INT interrupt pin.
Contents of the registers in the device structure are updated prior to this event, so the interrupt registers directly from this
structure (without sending 12c command) can be read.

6.4.1.2

If an interrupt from the battery charger occurs, an Oninterrupt event is invoked. (This interrupt handler is located in the Events.c file in
the Sources folder of your project.) When such an interrupt occurs, there are two options. The first is to read the Interrupt registers directly
from Battery charger. The second is to read the interrupt registers from the data structure DeviceData, which is updated prior to the
Onlinterrupt event being invoked. The Oninterrupt event is useful when setting a flag to report some event has occurred is needed.

Interrupt handling
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6.4.2 FRDM_BC3770 Processor Expert component

While the BC_MC32BC3770 component provides an interface for the battery charger, the FRDM_BC3770 component covers all the
functionality of the FRDM-BC3770-EVB Freedom board. The FRDM_BC3770 component facilitates user application testing and

evaluation by providing an API for current, voltage, and temperature measurement, and for Electronic load settings.

This section summarizes main features of the FRDM_BC3770 component and provides an overview of the properties appearing in the
Component Inspector view. Table 9 lists all of the methods and events related to the component. Figure 35 shows typical Component
Inspector properties for a project using the FRDM_BC3770 component.

% Component Inspector - BCFL 53

Properties . Methods | Events

Mame

Component Name
BC_MC32BC3770
Channelillocator
4 12C Communication
I2C Link
4 ELOAD
LDAC Link
A LDAC Synchrenization Pin
RDY/BSY Link
A Ready/Busy Status Pin
ELOAD Current
Voltage and Current Measurement
a NTC Thermistor
ADC Link
ADC Device
ADC Conversion Time
A NTC_TEMP Pin
MTC Reference [Ohm]
NTC A [104-3 K~0]
NTC B [10"-4 K-1]
MNTC C [104-6 K*-2]
NTC D [104-7 K*-3]
a Additional Pins
GreenLED Link
A Green LED Pin
RedLED Link
A Red LED Pin
Auto Initialization

Basic 5 Sl ]

Value Details
BCFL

KD5repository/BC_MC32BC...
KDSrepository/ChannelAllo...

CI2C2

Enabled

Kinetis/BitlO_LDD
PTD4/LLWU_P14/5P_PCS..
Kinetis/BitlO_LDD
PTAL2/TPM1_CHO

0 bl
Enabled

Enabled

ADL Sets conversion time.
ADCO ADCO
16666667 ticks 16.667 ticks
ADCO_SE11/TSIO_CH15/PT...

10000 1]
3354016

2569355

2626311

0675278

Enabled

Kinetis/BitIO_LDD

PTB&/EXTRG_IM

Kinetis/BitlO_LDD

PTES

yes

1 3

Figure 35. FRDM_BC3770 properties

In the Component Inspector view, the FRDM_BC3770 component properties are divided into five sections:

1.12C Communication provides selection of the linked 12C_LDD component used for communication with the Current Sense

Amplifiers and Electronic load.

2. ELOAD (Electronic load) contains pin settings for the Electronic load’s LDAC and Ready/Busy pins. LDAC is used as a flag for
transferring the contents of the input registers to their corresponding DAC output registers. Ready/Busy pin is a status indicator of
EEPROM programming activity. ELOAD Current sets the amount of current which the electronic load sinks from either battery or
VSYS output.

3. Voltage and Current Measurement enables the Current Sense Amplifiers (CSA) to measure VBUS, VSYS, and VBAT voltage
and current.

4.NTC Thermistor contains settings for temperature measurement. The ADC Link property links ADC_LDD component to the
FRDM_BC3770. The NTC A/B/CID properties are coefficients of the Steinhart-Hart equation used as an approximation for
temperature calculation from voltage measured on NTC thermistor. Find these coefficients in the data sheet for the NTC
thermistor. Note: make sure the number format of coefficients in the data sheet corresponds to the format in component
properties. For example, if the first coefficient NTC A is given as 0.5E-04 (or 0.5x10‘4), convert it to 0.05E-3 and enter only the
significant part of the number (i.e. 0.05). Otherwise the calculated value cannot correspond to the real temperature. The NTC
reference value is thermistor resistance at 25 °C.

5. Additional Pins offers pin settings for the green and red LEDs, which can be used as an indicator of some event in the user
application.
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6.421 I°C configuration

The FRDM_BC3770 component requires two different 12C_LDD components — one for FRDM_BC3770 and the other for
BC_MC32BC3770. This is because there are two I2C interfaces used on the Freedom evaluation board. One interface is used for
communication with the battery charger and the other handles communication with current sense amplifiers and electronic load. If the
project is not configured with two different 12C_LDD components, the Processor Expert reports an error.

> = 0Ss
4 [~ Processors
. 4 Cpu:MKL25Z128VLK4
4 (= Components
4 (= Referenced_Components
. §#f§ C2C1:2C_LDD
, Ry C2C2:12C_LDD
. & AD1:ADC_LDD
. &3 USB_LDD:USB_LDD
[+ 6B BCF1:FRDM_BC3770 | «——  Freedom Board Component
| > !:IB BC1:BC_MC32BC3770 |<— BC3770 Component
@ ChannelAllocatorl:ChannelAllocator
% LDACPin1:BitIO_LDD
8 RDYBSYPin1:BitlO_LDD
@ GreenLEDPinl:BitIO_LDD
@ RedLEDPinl1:BitIO_LDD
M FreedomBoard_Init
ectDevice

— ¢ Components

GetSelectedDevice
ELO Init

ELO SetCurrent
CSA Init

CSA_ReadRegister

CSA_WriteRegister

= = = = o

CSA_GetCurrent

CSA_GetVoltage

NTC_GetTemperature
[ SetLED

Figure 36. FRDM_BC3770 components panel with two 12c components
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FRDM_BC3770 component API

Table 9 describes all of the public methods and events related to the FRDM_BC3770 component. Component methods are also listed in
the Components panel as depicted in Figure 36. Methods and events marked with green check marks are included when source code is
generated; Methods and events marked with black crosses are not included (see Figure 36). To change these settings, go to the
Component Inspector panel and select the Methods tab. Note that some of methods/events are always generated, because they are
needed for proper functionality.

Table 9. BC_MC32BC3770 methods and events

Methods/events

Description

FreedomBoard_Init

Initializes devices on the board (current sense amplifiers and electronic load) assigns user defined data structure describing
the board.

SelectDevice

This method selects one of the devices on the board: electronic load or some of the current sense amplifiers to measure cur-
rent or voltage.

GetSelectedDevice

This method returns last selected device.

ELO_Init

This method initializes electronic load (ELOAD). Device MPC4728 is initialized with default values. Outputs B, C, and D are
in Power-down mode. Only output A, used for ELOAD control, is in Normal mode.

ELO_SetCurrent

This method sets the ELOAD set point (the amount of current ELOAD sinks). This method is the same as the internal
ELO_SetPointEload except for the function parameter, which is a real number [mA]. This method sends command 'new
value' to the output register of channel A. Resolution of output voltage is 12 bits. Command 'send new value' sets default set-
tings for other registers.

CSA_Init

Initializes the device and sets the default configuration (see documentation of INA230) of VBUS, VSYS, BATTERY amplifier
and settings of calibration register.

CSA_GetCurrent

This method reads the content of the Current Register for the selected device and converts it to current in milliamperes [mA].
To change the selected device, use the CSA_SelectDevice method.

CSA_GetVoltage

This method reads the Bus Voltage or Shunt Voltage register of the selected device according to the first parameter. The
value of the register is converted to voltage in millivolts [mV].

CSA_ReadRegister

Reads the content of the selected Current Sense Amplifier register.

CSA_WriteRegister

Writes value to the selected Current Sense Amplifier register.

NTC_GetTemperature

This method measures the voltage on NTC thermistor and calculates temperature according to the Steinhart-Hart equation.
Returned temperature is in Kelvin scale - T[K]. The precision of the resulting temperature depends on the NTC constants of
the equation. Add the correct constants A, B, C, D from data sheet of your NTC thermistor.

SetLED

This method turns on/off the green or red LED.
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6.5 Generating driver source code

After you have completed configuring the components, the application is ready to generate the driver code to be incorporated. The process
is as follows:

1. Click on the Generate Processor Expert Code icon in the upper right corner of the Components panel.

[ Project Explorer 52 g Y= 08

'15 BCF_KL25Z_Battery_Charger_BC3770_
5= BCF_KL25Z_BC3770_GUI_Usb_Hid

VS ——

4

Control_Usb_H »

-

< | [} »

%5, Components - BCF_KL25Z_Battery_Charger... 22 = O

OB e—

4 (= Generator_Configurations
@ FLASH
(= 0Ss
4 (= Processors
. 4P Cpu:MKL25Z128VLK4
(= Components
(= PDD

Figure 37. Generating the source code

2. The driver code for the device is generated into the Generated_Code folder in the Project panel. The component only generates
the driver code. It does not generate application code. Figure 38 shows the locations of the generated driver source code, Events
source code, and the appropriate location for user application code.

CodeWarrior Projects 53 = 08

4| B | & FileName ~
File Name = Build
4 - BCF_KL25Z Battery Charger_BC3770_Cont ‘
|= BCF_KL25Z_Battery_Charger_BC3770_Cor
. (== Documentation

Application source
Driver code is ;’,G‘FLASH _~" code belongs here
generated here —)I_-%*Generated_(:ode I
Processorkxpert.pe
» (= Project_Headers
> (= Project_Settings
|=] SaAnalysispoi
4 [~ Sources
Events are . |.¢] Events.c
generated here . [H] Events.h
> € main.c
. ] sa_mtb.c
> (= USB
. [~ Static_Code -

m

anager.apconfig

L g <

Figure 38. Source code locations
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6.6 Developing application code in Processor Expert

Processor Expert allows you to write application code, add component methods, and build your application without leaving the
CodeWarrior environment.

6.6.1 Writing the application code

All of the application code must reside in the Sources folder in the project directory. The code may modified in main.c and Events.c, but
retain the original comments related to usage directions.

6.6.2 Adding component methods

To add a component method into the application source code:
1.1n the Components panel for the project, click on Components. Find the desired method to add to the code.
2.Drag and drop the method directly into the source code panel.

3. Add the appropriate parameters to the method. (Hovering the mouse over the method displays a a list of the required parameters.)

Figure 39 shows an example of how to add a component method into the application source code. The example uses the MVHBridge
component. The process is the same for adding a BC3770 component method.

In the example, the MVHBridge component method list is opened, the RotateProportional method is dragged and dropped into main.c
and the necessary parameters are added.

1§ C/Co+ - MVHBLS in.c - CodeW. tudio | e
File Edit Source Refactor Search Project MQXTools ProcessorExpert Run Window Help —
@ R mlaae IR Fv xB-g- SRR R
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el e s - Basic [Advanced | @~

File Name B = -5
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(= Generated_Code #includ

£ ProcessorExvert.oe #includ

I 0 #include

#include "

es, which are used for whole
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A
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i
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B GetCurrentMeas
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Bl locetlonuidio
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#ifdef PEX_RTOS_START
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#endif

#include
#include "I0_¥
<

& Console 52

Processor Expert

ERS R R R
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Figure 39. Adding component methods
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6.6.3 Jumping into function source code

CodeWarrior is based on the Eclipse IDE allowing jumps directly into the source code of a function from within the main routine while
editing. To do so, CTRL and click. The source code appears in the edit window.

25 Rerex 50y

G KRB

3componeniGenersed Code/Cpuc
Fle £dt Source Refactor Seqch Projet MQXTools Processr Exp
Liw K~ o [ane -

5| et ey
B B &
a
0

Figure 40. Jumping into a function’s source code
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6.6.4 Building the project

To build the project, click on the hammer icon in the tool bar (see Figure 41). Alternatively, initiate a build by entering CTRL + B from the
keyboard.
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Figure 41. Compiling and downloading the application
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Figure 42. BC3770 charger
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7.2 USB connector
INPUT CONNECTORS
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Figure 43. USB connector
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7.3 VBUS current sense amplifier (CSA)
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Figure 44. VBUS current sense amplifier (CSA)
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7.4
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Figure 45. VSYS current sense amplifier
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7.5 VBAT current sense amplifier
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Figure 46. VBAT current sense amplifier
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Electronic load (ELOAD)
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Figure 47. Electronic load (ELOAD)

Freedom expansion boards FRDM-BC3770-EVB and FRDM-BC3770-EVM, Rev. 2.0

53

NXP Semiconductors



Schematics

7.7 KL25Z interface
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Figure 48. KL25Z interface
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7.8 NTC thermistor interface
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Figure 49. NTC thermistor interface
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7.9
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Figure 51. LED indicators
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8 Board layout
8.1 Silkscreen - FRDM-BC3770-EVB
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Figure 52. Assembly layer top
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Figure 53. Assembly layer bottom
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Figure 54. Top layer routing
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Figure 55. Inner layer1 routing

Freedom expansion boards FRDM-BC3770-EVB and FRDM-BC3770-EVM, Rev. 2.0

58

NXP Semiconductors



Board layout

PPPEO® ©0e®e®
PPOeoeee vovwee

Figure 56. Inner layer2 routing
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9

Board bill of materials

Table 10. Bill of materials (V)

Item | Qty Schematic label Value Description Part number p;srfty
NXP Components
IC PROGM SWT CHARGER 1.5 MHz W/DUAL
1 1 U1 OUT 5-5.2 V WLCSP25 MC32BC3770CS
Active components
IC CURRENT SHUNT MONI-
2 3 U20, U2z, U24 TOR 2.7-5.5V QFN16 - Texas Instruments INA230AIRGTT
3 1 U23 IC_ DAC QUAD 12BIT 2.7-5.5V MSOP10 - MCP4728-E/UN
Microchip Technology Inc
IC LIN OPAMP DUAL AUTO-ZERO 1.8-5.5
4 2 U21, U25 V SOICS8 - Microchip Technology Inc MCP6V07-E/SN
Capacitors
5 9 C1,C25 1.0 uF gSEACITOR CER 1.0 UF 10V 10% X5R 0805 - C2012X5R1A105K
6 9 C2, C4 22 uF iC)P(ACITOR CER 2.2 uF 25V 10% X7R 0805 - 08053C225KAT2A
7 1 c3 0.022 uF _Cﬁ:\leCITOR CER 0.022 UF 16 V 20% X7R 0805 0805YC223MAT2A
8 1 c5 47 yuF ﬁgl::,:tClTOR CER 4.7 UF 16 V 10% X7R 0805 - C0805C475K4RACTU
[ _
9 |1 |ce 0.4uF | CAPACITORCERO-TUR25V10% X7TR 0805~ | grua1Br1ET04KAOIL | @
10 |4 |c7,c20, C21,C24 04pF | CAPACITORCERO.TUF25V10% X7R 0805 - | Grma1BR71E104KAO1L
11 |3 | cs c22 c23 10 uF CHRACITOR GER 10 UF 16 V10% X5R 0805~ | 5g05vD106KAT2A
Inductors
INDUCTOR PWR 1 uH@1MHZ 2.2 A 20% 2520 -
12 1 L1 1.0 uH SAMSUNG CIG22E1ROMNE
Resistors
RESISTOR MF 1 K 1/8 W 5% 0805 - YAGEO
13 2 020, R27 1.0K AMERICA RC0805JR-071KL
14 |4 | R1,R2 R29,R30 15K RESSTORMF1.5K1/8 W 5% 0805 - KOA RK73B2ATTD152J
R3, R4, R5, R24, R28, R33, RESISTOR MF 10.0 K 1/8 W 0.1% 0805 -
15 8 R34, R35 10.0K BOURNS CRT0805-BY-1002ELF
RESISTOR MF ZERO OHM 1/8W -- 0805 -
16 1 R6 0Q YAGEO AMERICA RC0805JR-070RL
RESISTOR MF 2.4 K 1/8 W 1% 0805 - YAGEO
17 1 R7 24 K AMERICA 2322734624021
RESISTOR METAL STRIP 0.01 OHM 1 W 1%
18 3 R20, R23, R26 0.01Q 9512 - VISHAY INTERTECHNOLOGY WSK2512R0100FEA
RESISTOR WW 1.0 OHM 3.0 W 5% SMT - OHM-
19 1 R21 1.0Q ITE MANUFACTURING RW3RODB1RO0QJET
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Table 10. Bill of materials () (continued)

Board bill of materials

Item | Qty Schematic label Value Description Part number A;s:ty
20 1 R25 15.0 K RESISTOR MF 15.0 K 1/8 W 1% 0805 - KOA RK73H2ATTD1502F
SPEER
RESISTOR MF 220 OHM 1/8 W 5% 0805 - VEN-
21 2 R31, R32 220 Q KEL COMPANY CR0805-8W-221JT
22 1 R36 1.8K RESISTOR MF 1.80 K 1/8 W 1% 0805 - BOURNS | CR0805-FX-1801ELF
23 1 R37 47K RESISTOR MF 4.70 K 1/8 W 1% 0805 - BOURNS | CR0805-FX-4701ELF

Switches, connectors, jumpers and test points

HDR 2x8 2.54 MM FEMALE (STACKABLE) -

24 2 J1,J9 SAMTEC SSQ-108-23-G-D
HDR 2x10 2.54 MM FEMALE (STACKABLE) -
25 1 J2 SAMTEC SSQ-110-23-G-D
CON 1x5 USB MINI-B RA SHLD SKT SMT 0.8
6 |1 )8 MM SP 156HAU — HIROSE UX60-MB-5ST
27 6 44, J5. 47, J11, 412, J21 HDR 1x2 TH 100 MIL SP 339H AU 118L - HAR- M20-9990245
WIN INC
CON 1X3 TB TH 3.81 MM SP 201H -- 138L +
28 1 J6 TERM BLOCK PLUG 3.81 MM 3POS - SUBAS- | 210-80099, 211-79220
SEMBLY
CON 1X2 TB TH 3.81 MM SP 201H -- 138L +
29 1 J8 TERM BLOCK PLUG 3.81 MM 2POS - SUBAS- | 210-8009, 210-80098 )
SEMBLY
CON 2X10 SKT TH 2.54 MM CTR 340H AU 394L
30 1 J10 _SAMTEC SSQ-106-23-G-D
31 1 120 HDR 1x3 TH 100 MIL SP 340H AU 118L - HAR- M20-9990345
WIN INC
CON 1X3 TB TH 150 MIL SP 363H SN 134L -
32 J6_1 Phoenix Contact 1803439
33 J8 1 CON 1_X2 TB TH 150 MIL SP 363H SN 134L - 1803426
Phoenix Contact
34 1 LED1 LED GRN SGL 20 MA 0603 NRND - OSRAM LG L29K-F2J1-24-Z
35 1 LED2 LED RED SGL 30 MA 0603 - OSRAM LS L29K-G1J2-1-Z
TRANS NMOS PWR 24 A 30 V SO8 - Vishay
36 1 Q20 Technology S14156DY-T1-GE3
BOOT, ELOAD_DAC, LDAC,
LX, NCHGEN, NINT,
NSHDN, NTC_TEMP, PMID,
37 21 RDY/BSY, SCL1, SCL2, TEST POINT RED 40 MIL DRILL 180 MIL TH - 5000 @
SDA1, SDA2, VBAT, KEYSTONE ELECTRONICS
VBAT_ALERT, VBUS,
VBUS_ALERT, VL, VSYS,
VSYS_ALERT
TEST POINT BLACK 40 MIL DRILL 180 MIL TH - 2
38 3 PGND1, PGND2, PGND3 KEYSTONE ELECTRONICS 5001 @)
Notes
1. NXP does not assume liability, endorse, or warrant components from external manufacturers are referenced in circuit drawings or tables. While
NXP offers component recommendations in this configuration, it is the customer’s responsibility to validate their application.
2. Do Not Populate
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Following are URLs where you can obtain information on related NXP products and application solutions:

Table 11. References

NXP.com support pages

Description

URL

FRDM-BC3770-EVB

Tool Summary Page

http://www.nxp.com/webapp/sps/site/prod_summary.jsp?code=FRDM-BC3770-EVB

MC32BC3770 Product Summary Page | http://www.nxp.com/webapp/sps/site/prod_summary.jsp?code=BC3770
FRDM-KL25Z Product Summary Page | http://www.nxp.com/webapp/sps/site/prod_summary.jsp?code=FRDM-KL25Z
N i i ’) = i -
CodeWarrior Tool Summary Page http://www.nxp.com/webapp/sps/site/homepage.jsp?code=CW_HOME&tid=vanCODEWAR

RIOR

Processor Expert Code
Model

Code Walkthrough Video

http://www.nxp.com/video/processor-expert-code-model-codewarrior-code-walkthrough:PR
OEXPCODMODCW_VID

NXP.com videos

Description

URL

FRDMKL25ZINTRO_VID

Freedom Introduction
Video

http://www.nxp.com/webapp/video_vault/'videoSummary.sp?code=FRDMKL25ZINTRO_VID

FRDM-BC3770-EVB Quick
Startup

Startup Instructions

http://www.nxp.com/webapp/sps/site/prod_summary.jsp?code=FRDM-BC3770-EVB

USB Connection Panel

Configuring USB Con-
nections

http://www.nxp.com/webapp/sps/site/prod_summary.jsp?code=FRDM-BC3770-EVB

Direct 12C Communication
Panel

Configuring Direct 12C
Communications

http://www.nxp.com/webapp/sps/site/prod_summary.jsp?code=FRDM-BC3770-EVB

Control Registers Panel

Configuring Control Reg-
isters

http://www.nxp.com/webapp/sps/site/prod_summary.jsp?code=FRDM-BC3770-EVB

Script Editor Panel

Editing and running
scripts

http://www.nxp.com/webapp/sps/site/prod_summary.jsp?code=FRDM-BC3770-EVB

Charge Plots

Monitoring battery charg-
ing

http://www.nxp.com/webapp/sps/site/prod_summary.jsp?code=FRDM-BC3770-EVB

Discharge Plots

Monitoring Discharge
Plots

http://www.nxp.com/webapp/sps/site/prod_summary.jsp?code=FRDM-BC3770-EVB

Load Sharing

Describes the load shar-
ing support via the GUI

http://www.nxp.com/webapp/sps/site/prod_summary.jsp?code=FRDM-BC3770-EVB

Battery Supplement

Describes battery supple-
ment support via the GUI

http://www.nxp.com/webapp/sps/site/prod_summary.jsp?code=FRDM-BC3770-EVB

OTG Boost

Describes OTG Boost
support via the GUI

http://www.nxp.com/webapp/sps/site/prod_summary.jsp?code=FRDM-BC3770-EVB
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http://www.nxp.com/webapp/sps/site/prod_summary.jsp?code=FRDM-BC3770-EVB
http://www.nxp.com/webapp/sps/site/prod_summary.jsp?code=MC32BC3770
http://www.nxp.com/webapp/sps/site/prod_summary.jsp?code=FRDM-KL25Z
http://www.nxp.com/webapp/video_vault/videoSummary.sp?code=FRDMKL25ZINTRO_VID
http://www.nxp.com/webapp/sps/site/prod_summary.jsp?code=FRDM-BC3770-EVB
http://www.nxp.com/webapp/sps/site/prod_summary.jsp?code=FRDM-BC3770-EVB
http://www.freescale.com/webapp/sps/site/prod_summary.jsp?code=BC3770
http://www.nxp.com/webapp/sps/site/prod_summary.jsp?code=FRDM-BC3770-EVB
http://www.nxp.com/webapp/sps/site/prod_summary.jsp?code=FRDM-BC3770-EVB
http://www.nxp.com/webapp/sps/site/prod_summary.jsp?code=FRDM-BC3770-EVB
http://www.nxp.com/webapp/sps/site/prod_summary.jsp?code=FRDM-BC3770-EVB
http://www.nxp.com/webapp/sps/site/prod_summary.jsp?code=FRDM-BC3770-EVB
http://www.nxp.com/webapp/sps/site/prod_summary.jsp?code=FRDM-BC3770-EVB
http://www.nxp.com/webapp/sps/site/prod_summary.jsp?code=FRDM-BC3770-EVB
http://www.nxp.com/webapp/sps/site/prod_summary.jsp?code=FRDM-BC3770-EVB
www.nxp.com/webapp/sps/site/homepage.jsp?code=CW_HOME&tid=vanCODEWARRIOR
www.nxp.com/video/processor-expert-code-model-codewarrior-code-walkthrough:PROEXPCODMODCW_VID
www.nxp.com/video/processor-expert-code-model-codewarrior-code-walkthrough:PROEXPCODMODCW_VID

10.1 Support

Visit www.nxp.com/support for a list of phone numbers within your region.

10.2 Warranty

Visit www.nxp.com/warranty to submit a request for tool warranty.
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